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WARNING! Depending on the number of decoders enabled and the decoding settings, 
the program can be extremely CPU intensive! To the point of effectively making your 
computer non-functional. Start with one decoder with a selected sound input device 
when changing the other settings, especially the integration step, then enable additional 
decoders one by one, by selecting a sound input device, while watching the CPU usage 
in the Task Manager (Windows) or Activity Monitor (macOS). 
 
 
Known issues: 
 
If you don't see any sound devices, quit and run again. 
 
 
Requirements: 
Windows 8/10 
macOS 10.10.5 or later 
 
Introduction 
 
Black Cat ALE is a multi-channel ALE decoder. Up to 4 decoders can run at the same 
time, up to 24 when in high performance mode. See the section further down in the 
documentation.  
 
Each decoder can be connected to its own audio input source (a virtual audio cable - 
VAC, or physical sound input device). 
 
 
Purchase and licensing: 
 
You can, and should, fully test this program prior to purchase. Other than some usage 
time restrictions, it is fully functional. If something “doesn’t seem to work”, or work the 
way you want it to, in trial mode, it’s probably not going to work differently once you 
have paid. So be sure to address any issues prior to purchase, as refunds are not 
available.  
 
Two Black Cat ALE license codes are available. The regular license code allows for up 
to 3 decoders running at the same time, the Pro up to 24. Updates from the former to 
the latter are also available. A license code will work with the current release version at 
the time of purchase as well as any updates released over the next year. Use of 
updates past then will require a renewal of your license code. Of course your license 
code will continue to work with the previous versions, should you not wish to renew.  
 



Note that until you purchase a Pro license code for high performance mode, your usage 
of the program will be restricted in high performance mode to several hours at a time, 
requiring a restart of the program to continue. This provides ample opportunity to 
evaluate the program. Also note that in trial mode without any license code, your usage 
may also be limited (but again you can restart the program to continue using it).  
 
Visit the Black Cat ALE program page to purchase your license code, when you are 
ready: https://blackcatsystems.com/software/black_cat_ale_decoder.html 
 
 
 
 
 
Basic operation: 
 
The program defaults to one decoder It’s recommended to get some experience in 
single decoder mode first, before enabling additional decoders.  
 
Select the sound input device from the popup menu. In most cases, you can ignore the 
Left/Right channel selection unless your sound input device supports different audio 
feeds on each channel 
 
You should start to see activity in the spectrum and volume displays, once you start 
feeding audio from a radio into that audio channel. The gain slider can be used in some 
cases to adjust the input level, but note that not all sound devices support this 
capability. If you don’t see activity, troubleshoot your audio connection/settings. 
Tick the graph checkbox and a graphical display of the audio volume over time will 
appear and update. 
 
The receiver frequency can be entered into the Frequency text box, optionally with the 
mode (USB or LSB). This information will be added to displated ALE decodes.  
 
Assuming you’re tuned to a frequency with ALE transmissions, you should eventually 
start to see some decodes appear. If you have audio recordings (WAVE file format) of 
ALE signals, you can also feed them into the decoder, see the section further down in 
the documentation on this feature. 
 
Most ALE transmissions are in USB mode, and on integer kHz frequencies, such as 
6850.0 kHz, etc. A lesser number of transmissions are on half kHz steps, such as 
6873.5 kHz. A smaller number of ALE transmissions are in LSB mode, and an even 
smaller number are on other fractional frequencies, such as 8476.1 kHz.  
 
 
Setup: 
 
The program defaults to one decoder. Select Settings from the Edit menu to change the 



number of decoders as well as other settings.  
 
NOTE: You must close this window after making changes, for those changes to take 
effect! 
 
NOTE: If you wish to use more than 3 decoders, you will need to enable high 
performance mode. If you change the number of decoders, you must quit and restart 
the program for that change to take effect. 
 

 
Figure 1: Select the number of Decoders/VACs 1 … 24 from the dropdown menu ”Decoders” in the Settings tab. Re-launch the 
app. 

 
 
There are also some additional settings: 
 
Integration Step: How closely Black Cat ALE looks for signals. The smaller the number, 
the more closely, but also the more processing time required. Experimentation has 
shown that a value of 30 is generally quite adequate, and even 70 or 100 works well for 
most cases. Very small numbers can help extract weak signals out of the noise, at the 
expense of more CPU use. 
 
 



Skip After Decode: After a valid message is found, how many sound samples skipped 
(ignored) until decoding starts again. This should generally be left to the default value. 
 
 
Minimum Signal: The required minimum strength of the demodulated audio to trigger a 
decode. This should generally be left to the default value. 
 
 
Filter out non ASCII 38 messages: Don't display messages with characters outside of 
the ALE specified ASCII 38 character set. This should generally be left to the default 
value. 
 
 
Message Format: Controls the format of a displayed message: 
 
Space Delimiter, a message looks like this: 
[01 6907 USB 2021-10-13 22:20:55 24] TO EWD | KA=1 MP=7 
SINAD=31 BER=31  | TIS 4BUAAR 
 
Tab Delimiter (1), a message looks like this: 
01 6907 USB  2021-10-13 22:20:55 24 TO EWD | 
KA=1 MP=7 SINAD=31 BER=31  | TIS 4BUAAR 
 
Tab Delimiter (2), a message looks like this: 
01 6907 USB  2021-10-13 22:20:55 24 TO EWD KA=1 
MP=7 SINAD=31 BER=31  TIS 4BUAAR 
 
Tab Delimiter (3), tabs between all fields. A message looks like this: 
01  6973.0 USB 2021-10-17 08:43:51 0 TO ZEN TIS
 CM2  
 
UDXF, formatted for posting logs to the UDXF mailing list. A message looks like this: 
06950.0 69PMSANMIGUEL: TWAS ALE/USB (14OCT21 0536) (MD) 
 

 
Figure 2: Six variations of the same message but with different message formats. 

 



 
Maximum BER: Maximum allowed Bit Error Rate. Compares the number of bit errors 
between three successive ALE words. 48 would ignore all bit errors, 0 means the word 
must be received with no bit errors.  
 
 
Neaten formatting: always prints frequencies with tenth kHz, and pads spaces in front of 
the kHz, for a uniform width. 
 
 
Only Display Parsed Messages: Don't display the raw ALE words. Most users will want 
to select this. 
 
 
Print Duplicates: When displaying raw ALE words, duplicate words (same word and 
timestamp) will be displayed. Duplicate parsed messages will also be dropped. 
 
These two settings result in four possible ways of controlling what is displayed: 
 
Only Display Parsed Messages ON, Print Duplicates OFF:  The least output, only fully 
formed messages will be displayed, no duplicates. 
Only Display Parsed Messages ON, Print Duplicates ON:  Only fully formed messages 
will be displayed, with duplicates. 
Only Display Parsed Messages OFF, Print Duplicates OFF:  Fully formed messages 
will be displayed, along with raw ALE words. 
Only Display Parsed Messages OFF, Print Duplicates ON:  Fully formed messages will 
be displayed, along with raw ALE words, with duplicates of each. Will produce a lot of 
output. But this can be useful if you are decoding very weak signals, when not all of the 
ALE words may be received, resulting in only partial display of messages, or none at all 
in some cases. 
 
 
Callsign information popup menu: controls whether or not details for a callsign are 
displayed, values are: No Callsign Info, Print Organization, Print Details Also. See the 
section further down regarding the next file necessary for this feature. 
 
 
End of Tx Dead Time: Used to decide when an ALE transmission has ended, and 
display any remaining buffered message. I suggest 3 seconds for now as a value, but 
you can experiment. 
 
 
IPC Auto Connect: For future use. 
 
 
Minimum RX Words: Sets the minimum number of ALE words that must be received for 



a parsed message to be displayed. The decoding routines in Black Cat ALE are 
extremely sensitive and intensive, and try to find any possible ALE signal. Sometimes 
noise can fool the routines. This can help filter out extraneous random decodes from 
noise, caused by the high sensitivity of the decoder. It does not stop the printing of raw 
ALE words. A value of 2 or 3 will probably be sufficient, but the user can experiment. 
 
 
Print file decode information: Adds the name of the WAVE file to the decoded text 
 
Auto Log: Check the box and Set the name of the log file, and it will automatically be 
opened at program launch, so you don’t have to do this manually each time you run it.  
 
 
 
Decoders: 
 
Each decoder appears in its own tab in the main window. There is also a tab named 
"Combined" on the far right, this displays the text from all decoders in one easy to read 
display. 
 

 
Figure 3: Up to 24 decoders can be set. It is a good idea to match the decoder number (1 …24) to the VAC number (VAC1 
…VAC24). 

 
For each decoder, there are several settings: 
 
Sound Input: The device (physical or VAC) to use, along with which sound channel (left 
or right) to use. The latter can sometimes be used to double the effective number of 
VACs on your system, if your SDR or other software can feed audio to just a single 
channel, vs stereo.  
 



Gain: The gain setting for an audio input. Not all devices support changing the gain, so 
it may do nothing on your setup. 
 
Frequency: This is a text field for your own personal use. When ALE messages are 
displayed, the frequency is included, this is useful when looking at the combined 
display, or logging files, so you know what you're looking at. The decoder makes no 
additional use of this value. 
 
Graph: Enables/disables the moving display of sound data. You can turn this off to use 
a little less CPU time, as well as gain a little more decode text space. 
 
There's also a volume indicator as well as a simple audio spectrum display, for 
diagnostic/tuning purposes. 
 
You can right click in the decoded text area to select all the text, copy text, or clear the 
text. 
 
Each line of a fully parsed message contains this information: 
Decoder number 
Frequency (with mode if you have entered it) 
Date 
Time 
Worst BER for any ALE word in the message 
ALE message, optionally with callsign information 
 
 
 
Decoding from audio files: 
 
You can decode a WAVE audio file. Go to one of the decoders, and select Decode 
Audio File from the File menu. It will be decoded into the selected decoder display.  
Only WAVE files can be decoded. Not mp3 or any other format. 
 
Multiple files can be selected, they will decode one after another. Don't change the 
decoder tab while files are decoding.  
 
Decoding of WAVE files is much faster than real time decoding, limited by the speed of 
your computer, often 10x real time processing.  
 
If the files are long, they will be read in chunks of approximately one hour's worth of 
data each. 
 
Internally, sound is processed at a 44.1 kHz rate, monophonic, 16 bits. If the sound file 
is different from this, it will be converted internally to this format. As this takes some 
time, the fastest processing will occur if the sound file is already in this format. 
 



The file name is parsed for the frequency and time/date/mode information. If it is found, 
it will be used when decoding messages, so they get timestamp corresponding to their 
actual time. Otherwise the current time/date is used. '' 
 
As of now, two formats are supported: 
 
1. That when you download an audio file from a KiwiSDR receiver in your web browser: 
sdr.hfunderground.com_2021-10-19T18_09_09Z_10242.00_usb.wav 
 
 
2. Files from my SDR playback program mySdrPlayback: 
 
Frequency(kHz) [space] Mode(LSB/USB) [space] day-Month-Year [space] 
hour.minute.second.wav 
 
For example: 
6950.0 USB 14-Oct-2021 05.36.27.wav 
 
Any deviation from this format will cause it to not be parsed. 
 

 
Figure 4: Decoding from an audio file. With a proper named file (marked), the decoder automatically timestamps each decode at 
the matching (original) time. Larger files are also automatically divided into pieces of one hour each. 

 
 
 
Monitoring a directory for new audio files to decode: 
 
Black Cat ALE can monitor a specific directory, looking for new WAVE files, and decode 
them automatically as they appear.   
 
Select Set Directory To Monitor For New Files from the File menu, and choose the 
directory in which sdrRewind will store demodulated WAVE files. (Create one if you 



need to) 
 
Select Monitor File Directory from the File menu. Black Cat ALE will start looking in this 
directory for new WAVE files. The name of these files must end in ".wav" or ".WAV". It 
will ignore any files that already exist in this directory.  
 
There is an option in Settings which allows for the automatic deletion of processed 
WAVE files, to save disk space.  
 
 
 
Printing additional information about callsigns: 
 
Black Cat ALE can use one or more text files to provide additional information about 
callsigns.   
 
You need to create a directory to store these callsigns. One suggestion is to create one 
called "ale_callsigns" in the Documents directory for your user account.  
 
From the Callsigns menu, pick Set Callsigns Directory… and then select the directory 
you created.  
 
When you use the Save/Load Decoder Configuration options, this directory will be 
saved and loaded. So you could have a different directory, and set of callsign text files, 
for each configuration. 
 
You can put one or more PLAIN TEXT files into this directory, the program will look for 
them when it is opened.  
 
The first line of each text file should contain this text on the first line: CALLSIGN_FILE 
 
These files should be a tab delimited list of callsigns, along with two or more descriptive 
fields (one for the organization and one for more details), with another tab between 
each. So: 
callsign [ tab] organization [tab] details [return] 
 
Any deviation from this format will cause it to not be parsed. 
 
When a callsign matches an entry in the list, the organization and/or details will be 
displayed after it, in curly braces { }. This functionality is controlled in the settings.  
 
If there are two or more callsigns with the same name, then information will not be 
printed for that callsign, instead "Ambiguous - multiple entries" will be printed. 
 
You can select which file to use from the Callsigns menu in the program. You can select 
"Load All" to load all of the callsign files. 



 
As each file is loaded, a line of text will be displaying indicating the number of callsigns 
in the file, the name of the file, and the total number of unique callsigns so far loaded 
into the program. 
 

 
Figure 5: Such a look-up table makes identification and logging easy. 

 
 
 
 
Logging: 
 
Start and Stop Logging can be used to route all decoded messages to a text file. Note 
that when you start logging, any existing file will not actually be erased, but will be 
appended to. 
 
Load/Save Decoder Configuration: 
 
Loads and saves the current setup for all defined decoders. Handy if you want to have 
banks of decoder setups for FEMA, COTHEN, FAA, etc.  
 



 
Figure 6: Here 18 frequencies, plus USB mode, of an UN mission’s net are saved in a configuration file, named 
“UN_mission_18.txt”. 

 

Figure 7: Be prepared – SDR software SDRC has been prepared for decoding all UN mission’s channels. VAC1 … VAC18 are 
designated to RX1 … RX18 and activated (“All”). Black Cat Systems’ ALE decoder mirrors that configuration. Now parallel 
decoding can start.  

 
There is an option in Setup to specify an "Auto Log" file. When this is done, and the 
checkbox is ticked, this log file will be automatically opened and written to each time the 
program is launched, saving you from doing this manually. 
 
Note that you must not have the log file you will be writing to open in any other program, 
or it will not be written to, and Black Cat ALE could misbehave/crash.  
 
 
Edit Menu: 



 
You can select the size, color, and font of the decode text here, plus enter your 
registration license code. 
 
 
Some Caveats About ALE Decoding: 
 
ALE transmissions are broken up into words, each of which contains up to three 
characters of a callsign, as well as the preamble type (TO, TIS, TWAS, etc). For 
callsigns of three (or fewer) characters, the entire callsign can be transmitted in a single 
word.  
 
Callsigns longer than three characters must be broken up into two or more words, the 
additional characters are transmitted via a series of DATA/REP words. Up to a total of 
five words can be sent, allowing for callsigns up to 15 characters in length. 
 
ALE words are sent several times, this redundancy helps, but does not eliminate, the 
chance of words being lost. It’s entirely possible that no words representing a certain 
portion of a callsign will be received, especially when signals are weak. This can result 
in a portion of the callsign being missed. For example, if the callsign of a station is 
ABCDEF, it’s possible that no words containing the DEF portion of the callsign will be 
received, resulting in the callsign ABC being displayed. So it’s critical that the user 
carefully examines the callsigns of received messages, noting possible cases of this 
occurring. Once you know the general format of callsigns in a particular ALE network, 
this becomes fairly easy. 
 
ALE words contain error detection/correction bits, this allows rejection in most cases of 
invalid words. But there is always the statistical chance that random noise will happen to 
produce an ALE word that passes these checks, especially in the case of very sensitive 
decoding software that is looking for weak signals down in the noise. It’s a tradeoff.  
 
There is an option in the settings that specifies the minimum number of valid ALE words 
that must be received for a message to be displayed. As this value is increased, the 
number of random decodes displayed is drastically reduced.  
 

  



Software License Agreement  

This is a legal agreement between you and Black Cat Systems. covering your use of 
Black Cat ALE (the "Software"). Be sure to read the following agreement before using 
the Software. BY USING THE SOFTWARE (REGARDLESS IF YOU HAVE 
REGISTERED THE SOFTWARE OR NOT), YOU ARE AGREEING TO BE BOUND BY 
THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF 
THIS AGREEMENT, DO NOT USE THE SOFTWARE AND DESTROY ALL COPIES IN 
YOUR POSSESSION.  

The Software is owned by Black Cat Systems and is protected by United States 
copyright laws and international treaty provisions. Therefore, you must treat the 
Software like any other copyrighted material (e.g., a book or musical recording). Paying 
the license fee allows you the right to use one copy of the Software on a single 
computer. You may not network the Software or otherwise use it or make it available for 
use on more than one computer at the same time. You may not rent or lease the 
Software, nor may you modify, adapt, translate, reverse engineer, decompile, or 
disassemble the Software. If you violate any part of this agreement, your right to use 
this Software terminates automatically and you must then destroy all copies of the 
Software in your possession.  

The Software and its related documentation are provided "AS IS" and without warranty 
of any kind and Black Cat Systems expressly disclaims all other warranties, expressed 
or implied, including, but not limited to, the implied warranties of merchantability and 
fitness for a particular purpose. Under no circumstances shall Black Cat Systems be 
liable for any incidental, special, or consequential damages that result from the use or 
inability to use the Software or related documentation, even if Black Cat Systems has 
been advised of the possibility of such damages. In no event shall Black Cat Systems's 
liability exceed the license fee paid, if any.  

This Agreement shall be governed by the laws of the State of Maryland. If for any 
reason a court of competent jurisdiction finds any provision of the Agreement, or portion 
thereof, to be unenforceable, that provision of the Agreement shall be enforced to the 
maximum extent permissible so as to affect the intent of the parties, and the remainder 
of this Agreement shall continue in full force and effect.  

The Software and documentation is provided with RESTRICTED RIGHTS. Use, 
duplication, or disclosure by the Government is subject to restrictions as set forth in 
subdivision (b)(3)(ii) of the Rights in Technical Data and Computer Software clause as 



252.227-7013. Manufacturer is Black Cat Systems., 4708 Trail Court, Westminster, MD 
21158, United States of America.  

The name "Black Cat Systems", and “Black Cat ALE " are trademarks of Black Cat 
Systems. Black Cat ALE is ©2021-2022 by Black Cat Systems. All rights reserved 
worldwide.  

 


